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1. Introduction  

This document provides hardware and software installation instructions for the 
EyeLink 1000 and EyeLink 2000 system using either the Tower or Desktop mounts, 
and the EyeLink Remote. For the simplicity of presentation, these eye trackers are 
collectively referred to as the EyeLink 1000 throughout this document, with important 
exception noted where necessary.  

 

IMPORTANT: Before proceeding with the EyeLink 1000 installation ensure 
you have backed up all important data on your Host PC. 

 

The basic steps in installing the EyeLink 1000 system are: 

1) Unpack and Install the EyeLink 1000 Hardware. This includes connecting the 
Host PC to the Display PC via an Ethernet link. 

2) Install necessary Operating System and EyeLink 1000 Host Application software 
on the PC your have selected to act as your Host PC.  

3) Install the EyeLink 1000 Windows Software (API and example experiments) on 
the Display PC. 

4) Test the installation. 

The installation process will take about 2 hours, so try and do it when you have this 
amount of time to dedicate to the process.  

If you have questions or encounter a problem during the installation process, please 
contact SR Research through one of the contact channels listed at: 

http://www.sr-research.com/contact.php 

If you would like to ensure that a technical representative is available for direct phone 
support during your installation, please contact your SR Research representative to 
book a time for installation phone support. We will ensure that a technical 
representative is available to speak on the phone with you if required during your 
installation if you inform us of your installation time with at least one week’s notice. 

1.1 Suggested Equipment Layout 

The layout of the EyeLink 1000 equipment is important if participant setup is to be 
convenient, and lighting problems are to be avoided. Before setting up equipment, 
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check the arrangement of the room to be used against these suggestions. These will aid 
in the production of good experimental data. 

• Set up the host and display monitors and PCs on tables arranged in an ‘L’ shape, as 
in Figure 1-1. This configuration allows the experimenter to adjust the eye tracker 
device and set up the subject for the experiment while having access to both 
computer keyboards and monitors. 

 

Figure  1-1 Suggested EyeLink 1000 System Layout  

 

• If you are using the chinrest that comes with the eye tracker, please make sure you 
have a table available to mount the table clamp. This table must have a minimum 
thickness of 1.8 cm and a maximum thickness of 8.0 cm. The bottom edge of the 
table should have a depth of at least 6.0 cm to mount the integrated table clamp. 
Please also ensure that the table is deep enough to accommodate both the monitor 
(especially for a CRT monitor) and eye tracker. For a 21’’ CRT monitor with a 30° 
viewing angle, the minimum table depth should be about 130 cm.  

• Avoid windows or other bright light sources that could cause reflections on the host 
and display monitors. The grey walls highlighted in Figure 1-1 are locations where 
bright light sources will cause reflections. 

• Supply sufficient light in the room. The best way to light the room is with ceiling-
mounted fluorescent lights, above and no more than 2 meters behind the computer 
monitors. Painting the walls light colors or white will maximize ambient light as well. 
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• Avoid environmental distractions. Be sure the room can be kept quiet, that no 
posters or other items are on the wall seen by the participant, and so on. It is also a 
good idea to make sure the participant cannot see the host monitor, without turning 
their head (discourage this). 

• Supply a comfortable, stable chair for the participants. It should not wobble or move 
when sat in, and the back should be firmly attached to the seat - springiness 
encourages some participants to rock forwards and back. A chair with a concave 
back also discourages shifting of the body, as does a high back. The top of the chair 
back should be just below the shoulders on an average participant. Finally, make 
sure participants can enter and leave the chair easily, as the chair will be close to 
the table with the Display PC monitor.  

• Set up the Display PC monitor and chair so that the participant’s eyes will be at a 
distance from the monitor of about twice the width of the display area of the Display 
monitor. This distance gives a display area of 28° by 22°. This is the ideal distance 
for both calibration accuracy and tracking range. This standard distance is assumed 
in all EyeLink 1000 documentation. 

1.2 Pre-installation Checklist 

Ensure that you have the following resources available before you start installation. 
These items have all been provided with your EyeLink 1000 system shipment: 

1. EyeLink 1000 head support hardware (including IR mirror, built in IR 
illuminator, and chinrest tower) 

Or EyeLink 1000 Desktop Mount (including desktop stand, an integrated IR 
illuminator, and optional chin rest and forehead rest).  

Or EyeLink Remote (including desktop stand, an integrated IR illuminator, and 
a roll/sheet of targets).  

2. EyeLink CL High Speed Infrared Camera 

3. CameraLink frame grabber – PCI card 

4. DLINK DFE538-TX Ethernet PCI card 

5. Power supply for the EyeLink CL High Speed Infrared Camera. 

6. CameraLink cable to connect EyeLink CL camera to PCI frame grabber card. 

7. Ethernet cable to connect Host and Display PC together. 
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8. “EyeLink 1000 Software” CD. Please note that each EyeLink 1000 system loads 
a camera-specific .SCD file and therefore, you should use the EyeLink 1000 
Installation CD that comes with your system. 

9. One ROMDOS Boot floppy disk or CD labeled “ROMDOS Boot Disk / CD” 

10. One System Commander Boot floppy disk or CD labeled “System Commander 
Boot CD” 

11. USB Button Box to be attached to the host computer and USB extension cord. 

 

You will also need the following components that may not have been provided with 
your EyeLink 1000 base system: 

1. A Host PC that meets the minimum required specifications. These specifications 
are listed in section 2.1.1. The Host PC may have been purchased with your 
base system. 

2. A Display PC that meets the minimum required specifications. These 
specifications are listed in section 2.1.2. 

3. Any tools required for accessing your Host PC’s case (usually a Phillips 
screwdriver will do). 

 

If an analog card option was purchased, you should also have: 

1. Full length PCI Analog card  

2. Analog breakout board 

3. Cable to connect analog PCI card to breakout board. 
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2. Suggested Computer Specifications 

2.1.1 Host PC 
The PC that will host the EyeLink 1000 card must meet certain requirements. Please 
contact SR Research Ltd. for currently recommended computer systems. 

• Pentium 4 2.8 GHz or faster CPU with full SSE3 instruction set support 
• 80 GB hard disk with 7,200 rpm  
• 128 MB Video card supporting 800 × 600 resolution, 256 color mode using the 

VESA 2.0 BIOS. 
• A CD-ROM writer for software installation and data backup. 
• 512 MB RAM 
• 3.5 inch 1.44MB Floppy Drive (optional) 
• At least two free PCI slots for two half-length PCI cards (3 free slots needed if 

using analog card option) 
• Minimum 160 W power supply (200 W recommended), capable of supplying at 

least 0.2 A on the –12 V output. See the Specifications for the full power 
requirements of the EyeLink 1000 system.  

• A PS/2 or USB mouse or other pointing device 
• A PS/2 keyboard is suggested; a USB keyboard will work. 
• Optional USB port for button box (UHCI-compatible only) 
• Optional operating system: Windows2000/XP for use in data backup, 

maintenance and data analysis. 
• Optional secondary Ethernet card for use on local network (the EyeLink 1000 

system is provided with a specific Ethernet card that must be used for any 
direct connection to the display PC). 

• A computer monitor 
  

2.1.2 Display PC 
The specifications for the PC that will be used for system calibration and experiment 
presentation depend greatly on the type of experimental paradigms that the EyeLink 
1000 will be used for. For example, gaze contingent paradigms generally require more 
computing power than simple cognitive paradigms because the computer display needs 
to be updates as quickly as possible. The following requirements are suggestions for a 
Display PC configuration that should be able to handle most experimental 
requirements. Please contact a SR Research Ltd. Representative if you have specific 
questions about your situation and would like our input.  

• > 2.0 GHz or faster processor (Pentium 4 or AMD).  
• 80 GB hard disk with 7,200 rpm 
• Video card supporting vertical refresh rates of 100 Hz 
• A CD-ROM writer for software installation and data backup. 
• At least 512 MB RAM (1 GB recommended) 
• 32 bits Windows 2000 or 32 bits Windows XP (service pack 2). 
• 19” or larger monitor that supports vertical refresh rates of >= 100Hz and 

horizontal refresh rates > 100 kHz. 
• Ethernet card to connect Display PC to the EyeLink 1000 Host PC. 
• Optional Ethernet card for use on local network (a separate network card should 

be used to connect to the EyeLink 1000 system) 
• A keyboard and mouse or other pointing device. 
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3. Hardware Installation 

IMPORTANT: Switch off the computers before installing any PCI cards or 
connecting or disconnecting any cables! Ensure that all cabling is properly 
connected and connectors are properly secured to the Host PC and the 
EyeLink CL camera before use. 

IMPORTANT: Ensure that the power supply setting on the back of the 
PC (Near the power jack) matches your local supply voltage! 

WARNING: Static Electricity Discharge may cause permanent damages 
to your system. In order to avoid possible static electricity discharge 
during installation, please discharge any static electricity accumulated 
in your body by touching a grounded metal surface or the computer 
case for a few seconds. 

3.1 Unpacking 

Open the shipping case. If you are unpacking the large shipping box that contains 
the EyeLink 1000 Tower Mount, please be careful as it contains glass that may 
have been broken during shipping. If the system has been stored or transported at a 
temperature below 10°C, allow all parts to warm to room temperature before 
proceeding. 
 
   

IMPORTANT: Save the shipping case and all packing material for storage or 
in case the unit needs to be returned for repair. 

IMPORTANT: The EyeLink 1000 Tower assembly should be held by the 
vertical posts and should NEVER be held by the mirror or the 
components attached to the mirror. 

3.2 Host PC Hardware Installation 

3.2.1 Setting Up the Host PC Computer and Monitor 
Unpack your Host PC as per the instructions provided with the computer by the 
computer manufacturer and set up the computer at the desired location. This includes 
connecting the keyboard and mouse to the computer, as well as the power supply and 
monitor cables.  
 
If your EyeLink 1000 system was supplied with the hardware preinstalled into a 
supplied Host PC, please skip to section 3.6 “Attaching EyeLink 1000 System Cabling”; 
otherwise please follow these next steps to set up your Host PC for use with the 
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EyeLink 1000 system. You will be required to access the computer chassis to install 
two or three PCI cards so put the computer case in a position where you can easily 
access the computer’s PCI slots. 
   

IMPORTANT: Ensure the computers power cable is disconnected before 
opening the computer chassis to install any PCI card. 

IMPORTANT: Handle the cards only by their edges. 

 

3.2.2 Installing the Phoenix High Speed Frame Grabber - PCI card 
 
Open the EyeLink 1000 host PC, and insert the Phoenix High Speed Frame Grabber 
card into a free PCI slot. Ensure the card’s bracket is firmly attached to the PC. 
 

 

Figure  3-1 Phoenix High Speed Frame Grabber 

3.2.3 Installing the DLINK DFE-538TX Ethernet Card 
Insert the DLINK DFE-538TX Ethernet Card into a free PCI slot. Ensure the card’s 
bracket is firmly attached to the PC. If the analog card option was not purchased with 
your system, you may now close the computer chassis and reconnect the power supply 
to the computer. 
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Figure  3-2 Ethernet Card 

3.2.4 Installing the Data Translation Analog Card (Optional) 
If the analog output option was purchased with your system, then insert the Data 
Translation Analog output card into a free PCI slot. Ensure the card’s bracket is firmly 
attached to the PC. Close the computer chassis and reconnect the power supply to the 
computer.  
 

 

Figure  3-3 Analog Card 

3.3 Display PC Hardware Installation 

Unpack your Display PC as per the instructions provided with the computer by the 
computer manufacturer and set up the computer at the desired location of the Display 
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PC. This includes connecting the keyboard and mouse to the computer, as well as the 
power supply and monitor cables. 

   

If you are setting up the EyeLink 1000 Tower Mount, please continue 
with section 3.4 “EyeLink 1000 Head Support Tower and Camera 
Installation”, otherwise, please read section 3.5 “EyeLink 1000 
Desktop and EyeLink Remote Installation”. 

3.4 EyeLink 1000 Head Support Tower and Camera Installation 

Please follow the steps below to mount the EyeLink 1000 head-supported tower onto 
the table and to install the camera. The following picture illustrates parts on the 
EyeLink 1000 tower that might be adjusted. 
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Figure  3-4 Components of EyeLink 1000 Tower 

3.4.1 Mounting Head Support Tower To Table 

 

Important: The head support tower should only be held by the vertical 
posts and should NEVER be held by the mirror or the components 
attached to the mirror. We recommend you have somebody available to 
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assist you mounting the head-support tower onto the table to prevent 
damages to the IR mirror or other parts of the tower.  

 

Check whether the table is suitable for mounting the EyeLink 1000 tower – the table 
used should have a minimum thickness of 1.8 cm and a maximum thickness of 8.0 cm.  

 

Figure  3-5 Clamping to Table 

Loosen the table clamp by turning the knob counterclockwise, place the table clamp 
fully onto the table, and then tighten it clockwise (see Figure 3-5). Check that it is 
firmly secured by gently attempting to rock the table clamp base free. If the table clamp 
base wobbles you shall have to proceed to tighten it further.  
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Figure  3-6 Camera Mounting Placed onto Tower Poles 

The camera mounting is quite heavy and cumbersome to move, it is recommended that 
for safety two people handle the moving of this part of the equipment setup. One person 
should support the weight of the camera mounting while the other lines the posts up 
with the holes and handles the clamps. Gently pick up the camera mounting with the 
mirror facing away from you. It is recommended that you hold the camera mounting 
near the tower height adjustment knobs as shown in Figure 3-6. Be careful not to 
scratch or touch the mirror. Now line the mounting up with the vertical posts and 
gently lower it into position. The camera mounting should rest about ½ inch into the 
hole. 

 

 

Figure  3-7 Tower Height Adjustment 

Once the Tower Mount is placed onto the tower poles you will need to adjust its height 
by pulling simultaneously the tower height adjustment knobs away from the poles on 
both the left and right hand side (see Figure 3-7). Be careful as you shall still have to 
support the weight of the camera mounting unit. Make sure that the camera mounting 
does not fall down the poles. If at any point the camera mounting unit does begin to 
fall, if you release the tower height adjustment knob it should automatically click and 
lock into place, preventing the tower from falling further.  
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Figure  3-8 Adjust Height of Tower to Half the Screen Area of 
Monitor 

Gently lower or raise the camera mounting unit by pulling to release the height 
adjustment knobs, until the same tower height adjustment knobs are in line with the 
center of the display monitor (see Figure 3-8). This will produce an optimal viewing 
angle for participants. Once the tower height is set for a normal operation, it does not 
need to be adjusted further. The experimenter should just adjust the heights of the 
chair and/or chin rest on a participant to participant basis.  

3.4.2 Mounting EyeLink CL High Speed Camera  

The 25 mm lens should be used on the EyeLink 1000 Tower Mount. Hold the camera 
with the lens facing downwards and the focusing arm on the right. Align the hole on the 
camera to the screw on the top of the tower and tighten the screw knob from below. 
Please make sure the camera lens is not dusted or scratched! 

 

Figure  3-9 Views of the EyeLink 1000 Tower and Camera 
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Figure  3-10 Camera and Illuminator Cables on EyeLink 1000 
Tower 

 

After the camera is mounted onto the tower, connect the EyeLink CL power supply that 
was provided with your system to the power connector on the left side of the EyeLink 
CL camera. Connect the two illuminator cables that come out of the left side of the head 
support tower to the left side of the EyeLink CL high-speed camera: plug the cable 
marked with “R” to the port marked with “R” and the one with “L” to the remaining port.  

3.4.3 Adjusting Head Rest Components 

The height of the forehead rest and chinrest can be adjusted by loosening the knobs on 
both sides of the tower, sliding the tower and chinrest to the desired position, and then 
re-tightening the knobs.  

 Set up the monitor and chinrest so that the chinrest is centered on the monitor and 
the monitor is horizontally aligned with the chinrest (HINT: measure from the left 
and right knobs on the chinrest to the left and right sides of the top of the display 
area of the monitor, these should be equal). 
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 Adjust the tilt of the monitor and height of the forehead rest. Ideally this should 
have the top of the display at about the same height as the forehead rest, and the 
display tilted up slightly. The tilt can be changed if there are any reflection issues. 
Please follow Section 5 “Final Installation Steps” to modify the PHYSICAL.INI file 
settings.  

3.5 EyeLink 1000 Desktop Mount / EyeLink Remote Installation 

Please follow the steps below to set up the EyeLink 1000 Desktop Mount. Figure 3-11 
illustrates parts on the EyeLink 1000 Desktop Mount might be adjusted. 

 

 

Figure  3-11 EyeLink 1000 Desktop Mount Components 

3.5.1 Mounting EyeLink 1000 High Speed Camera  

The EyeLink 1000 Desktop Mount can be configured to track eye movements up to 
2000 Hz monocularly or 1000 Hz binocularly. The angle of the high-speed camera and 
the position of the camera screw should be adjusted differently depending on the 
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mount type you plan to use. Each mount type also require different camera lens (see 
table 1). 

 Tower Mount Desktop Mount – 
Camera Level 

Desktop Mount – 
Camera Angled 

EyeLink Remote 
– Camera Level 

16 mm (Short 
Focus Arm) 

No No No Yes 

25 mm  (Long 
Focus Arm) 

Yes Possible – closer 
distance 

suggested 

Yes No 

35 mm (No 
Focus Arm) 

No Yes Possible – 
further distance 

suggested 

No 

Table 1. Recommended Lens for Each Mount Type. 

 

 

Figure  3-12 EyeLink 1000 Desktop Mount Stand and Camera 

Follow the steps below to mount the high-speed camera for monocular tracking or 
EyeLink Remote (see Figure 3-13):  

1. Place the Desktop Mount on the table. Please leave the camera lens cap on to 
ensure the lens is not dusted or scratched!   

2. Move the camera screw to the top end of the slot.  
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3. Hold the camera with its elongation parallel to the table, align the hole on the 
camera to the camera screw on desktop stand, and then tighten the camera 
screw.  

 

Figure  3-13 Camera Position and Angle for Desktop (Level) 
and Remote (Level) Monocular Recording 

Follow the steps below to mount the high-speed camera for binocular tracking (see 
Figure 3-14):  

1. Place the Desktop Mount on the table. Please leave the camera lens cap on to 
ensure the lens is not dusted or scratched!   

2. Move the camera screw to the bottom end of the slot.  

3. Hold the camera with its elongation forming a 45-degree relative to the table, 
align the hole on the camera to the camera screw on desktop stand, and then 
tighten the camera screw. 
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Figure  3-14 Desktop Mount Camera Position and Angle for 
Desktop (Angled) 

After the camera is mounted onto the Desktop Mount, connect the EyeLink CL power 
supply that was provided with your system to the power connector on the left side of 
the camera (see Figure 3-15). Connect the two illuminator cables that come out of the 
Desktop Mount to the left side of the EyeLink CL high-speed camera.  

 

Figure  3-15 Camera and Illuminator Cables on EyeLink 1000 Desktop 
Mount  

3.5.2 Adjusting EyeLink 1000 Desktop Mount (Monocular, Binocular and 
Remote Recording) 

Place the Desktop Mount on the table at a distance between 40 and 70 cm from the 
participant’s eyes, with the illuminator and eye camera facing the participant; the 
recommended tracking distance is 50 to 55 cm. The camera screw of the Desktop 
Mount should be aligned to the center of the display PC monitor and the top of the 
illuminator should be as close to the lower edge of the visible part of the monitor to 
maximize the eye tracking range. 
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If you are using the chin rest supplied by SR Research Ltd., please check whether the 
table is suitable for mounting the chin rest – the table used should have a minimum 
thickness of 1.8 cm and a maximum thickness of 8.0 cm. Loosen the table clamp by 
turning the knob counterclockwise, place the table clamp fully onto the table, and then 
tighten it clockwise (see Figure 3-5). Check that it is firmly secured by gently attempting 
to rock the table clamp base free. If the table clamp base wobbles you shall have to 
proceed to tighten it further. Following this, mount the forehead rest to the chinrest 
and tighten the knobs. 

Please check that the chinrest is horizontally centered on the monitor. Adjust the tilt of 
the monitor so that the display is tilted up slightly. The tilt can be changed if there are 
any reflection issues. Please follow Section 5 “Final Installation Steps” to modify the 
PHYSICAL.INI file settings. 

3.5.3 EyeLink Remote Hardware Adjustment 

Place the monitor at a distance about 60-70 cm from the subject’s eye. The height of 
the monitor should be set so that when the participant is seated and looking straight 
ahead, they are looking vertically at the middle to top 75% of the monitor. Once you 
have set up the system, make sure you have updated PHYSICAL.INI, which is located at 
C:\ELCL\EXE folder of the host computer. Please check out section “5. Final 
Installation Steps” of the EyeLink 1000 Installation Guide.  

Check whether the camera is set to the horizontal position – the elongation of the 
camera should be parallel to the table (see section 3.5.1 “Mounting EyeLink 1000 High 
Speed Camera”). Place the eye tracker right in front of the monitor; the camera screw 
should be horizontally aligned to the center of the monitor. For maximum eye tracking 
range, the eye tracker should be raised so that the top of the illuminator is as close as 
possible to the lower edge of the visible part of the monitor without blocking the 
subject’s view. Internally the eye tracker was designed to perform base on these 
assumptions. Variability by a couple of centimeters will not have an impact on the 
tracker accuracy while a larger deviation from the recommended settings may cause 
performance issues. Contact SR Research Ltd. if you cannot set up your experiment 
according the above recommendations. 

3.6 Attaching EyeLink 1000 System Cabling 

For system cabling, please follow the wiring diagram in Figure 3-16. 
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Figure  3-16 System Set-up and Cabling. 

The basic cabling steps are: 

1. If not already done, attach the keyboards, mouse, power cords, monitors etc. to 
the Host and Display PCs. 

2. Connect one end of the Ethernet crossover cable provided with your system to 
the DLINK Ethernet card port on the Host PC. Connect the other end of the 
Ethernet cable to the Ethernet port on the Display PC that you will later 
configure for use with the EyeLink system. Ensure the cable is securely 
connected at both ends.  
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3. Connect one end of the CameraLink Cable provided with your system to the 
Phoenix High Speed Frame Grabber card in the Host PC. Connect the other end 
of the cable to the top of the EyeLink CL high-speed camera. Ensure the cable is 
firmly attached at both ends, with the two thumb screws tightened to lock the 
cable in place. Please note that if you have purchased both the Tower Mount 
and Desktop Mount, you will receive two CameraLink cables. The cable that has 
a right angle connector should be used on the Desktop Mount. 

4. Ensure that the two illuminator cables that come out of the head support tower 
or Desktop Mount have been connected to the left side of the EyeLink CL high-
speed camera.  

5. Connect the EyeLink CL power supply that was provided with your system to 
the power connector on the left side of the EyeLink CL camera. After the power 
supply has been connected to the camera, connect the power plug to a power 
surge protector. 

 

Important: Do not use any other power supply with the EyeLink CL camera 
other than the one provided with your system. 

 

6. Plug the supplied USB game pad into a USB port on the Host PC. Use the 
optional USB extender cable if the game pad needs to have a cord longer than 
one meter.  

NOTE: The USB game pad must be directly connected to a USB port on the 
Host PC and cannot be connected through a USB hub. 

 

7. If an analog card was installed in your Host PC, connect one end of the supplied 
analog card cable to the analog card connector on the Host PC. Connect the 
other end of the cable to the analog breakout board that was provided with the 
Analog card option. Ensure the cable is firmly attached at both ends and that 
the thumb screws have been tightened to lock the cable in place. 
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4. Software Installation  

Both the Host PC and Display PC need to be configured for use with the EyeLink 1000 
system. 

4.1 Host PC 

4.1.1 Operating System Installation 

The first step in preparing your Host PC for the EyeLink 1000 is to install the ROMDOS 
operating system that the EyeLink 1000 system runs on.  

4.1.2 Installing on a Computer Running Windows 2000/XP. 

The host PC runs the EyeLink eye tracker from the ROMDOS operating system. This 
allows you to perform subject setup, monitor performance, record data, and control 
experiments running on the subject PC. At the same time, you will want to keep your 
existing operating system accessible so that you can access your CDRW drive etc. when 
required. To achieve this, you will create a partition on your hard drive using System 
Commander that will host the ROMDOS OS provided with your EyeLink 1000 system. 
System Commander will also be used to allow you to choose which operating system 
you wish to launch when you start the Host PC.  

4.1.2.1 Install System Commander 

Install the System Commander application that came with your EyeLink 1000. This 
application allows the user to manage multiple Operating Systems on one computer.  

1. Insert the “EyeLink 1000 Software” CD into your CD drive 

2. Open the ‘Host PC Installation\Utilities’ folder and run the 
SystemCommander811.exe file to install the System Commander software 

3. Click the INSTALL button on the opening menu and follow the instructions to 
install the System Commander software. The license number will be on the front 
of the EyeLink 1000 Software CD case. You are only licensed for 1 copy of this 
software for use on the EyeLink 1000 Host PC. 
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Figure  4-1 License Code Entry 

Important: 

Create the System Commander rescue disks when prompted during 
installation. We have included 2 blank floppy disks with your system for this 
purpose.  

Do not register your System Commander. Your license is registered through 
SR Research Ltd. 

4. Restart your computer, which will start the System Commander application. 

5. There may be some information messages that appear, simply close them by 
clicking the ‘X’ in the top right corner. 

4.1.2.2 Resize existing disk partition  

Resize existing partition to make space for a 5GB EyeLink Host Application partition.  

1. Insert the System Commander Boot CD into the Host PC CD Rom drive. 

2. Either reboot your Host PC, or selected the “Boot from CD” icon in the 
System Commander ‘OS Selection’ window. Note: You may need to press 
F12 upon the computer restart to change the boot sequence. 

3. Once the Host PC has rebooted using the System Commander Boot CD, click 
the ‘Partitioning’ button from the ‘OS Selection’ window and follow the 
instructions to the ‘Partition Wizard’ dialog box. 
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Figure  4-2 Creating Partition 

4. Select ‘Manual partitioning’ and click ‘Next’ to bring up the ‘Partitioning’ 
window as illustrated in Figure 4-3. 

 

Figure  4-3 Manual Partitioning 

5. From the ‘Partitioning’ window select the disk and the partition to resize. In 
System Commander, each disk is represented as a cylinder. Within these 
cylinders are differently colored partitions. The partition (typically, this will 
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be in the primary disk) that should be resized to make a new partition will 
normally be the largest chunk within the selected disk. Highlight this 
partition as illustrated in Figure 4-4. 

 

Figure  4-4 Partition Section 

6. Click the ‘Resize’ button from the menu which will bring up a ‘Resize 
Partition’ window. 

7. In the “New size (MB)” field, enter a value that is 5120MB less than the 
indicated ‘Current Size’. For example, if the original disk size is 76253 MB, 
you should put 71133 MB in the new size field (see Figure 4-5).  



EyeLink 1000 Installation Guide (9/13/2007) © 2005-2007 SR Research Ltd.  26

 

Figure  4-5 Resize Partition 

8. Press ‘Next’ to do the resizing of the drive. 

NOTE: System Commander will adjust the partition size you entered slightly. 
This is expected and is not an issue.  

 

4.1.2.3 Create the EyeLink 1000 Host Application partition  

1. From the ‘Partitioning’ window select the newly formed unpartitioned space 
(highlighted in gray) which will appear on the top of the cylindrical drive diagram 
as illustrated in Figure 4-6. 
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Figure  4-6 Partition Selection 

2. Click the ‘Create’ button which will bring up the ‘Create Partition’ window. 

3. Select ‘Primary’ and click ‘Next’ which will bring up the ‘Create Primary Partition’ 
window as illustrated in Figure 4-7. 

 

Figure  4-7 Primary Partition labeling 
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4. In the ‘Volume label’ field type EYELINK and ensure that the ‘Custom Partition 
Type’ box is checked. Click ‘Next’ to bring up the ‘Custom Partition Type’ 
window as illustrated in Figure 4-8. 

 

Figure  4-8 Custom Partition Type 

5. Select ‘FAT-32’ and click ‘Next’ (see Figure 4-9). In the following ‘Warning!’ 
window, click ‘Proceed’. 
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Figure  4-9 Fat32 Selection 

6. Close the ‘Partitioning’ window by selecting the red “X” in the top right corner as 
illustrated in Figure 4-10. Exit System Commander by clicking "Start" at the 
bottom-left corner of the screen and then select the "Exit" option as illustrated 
in Figure 4-11.  
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Figure  4-10 Close Partitioning 
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Figure  4-11  Exit 

7. Remove the System Commander Boot CD from the Host PC CD-ROM drive. 

8. Upon restart the computer will automatically run the System Commander 
application (this will happen every time the computer is powered up). The new 
EyeLink partition will appear as the icon with the two question marks and will 
be labeled ‘FAT-32 OS’ as illustrated in Figure 4-12. 

 

 

Figure  4-12  FAT-32 OS Selection 

9. Select this icon to ensure the computer will boot into it. (NOTE: since an OS has 
not yet been installed on this partition, the computer will just hang after 
selecting the EyeLink 1000 partition. Ignore the message “Non-system disk or 
disk error; Insert DOS diskette and press any key” printed on the screen). 

10. Restart the computer again and select the Windows XP partition (NOTE on the 
initial boot into Windows XP, the system will perform a number of system 
checks. This is expected and should not be interrupted). 

4.1.2.4 Clean-up System Commander ‘OS Selection Menu’ 

1. Restart the computer after the Windows finishes performing the system checks. 

2. From ‘OS Selection Menu’ window, click ‘Settings’. 
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3. From the ‘Settings’ window, select ‘Descriptions and Icons’ as illustrated in 
Figure 4-13.  

 

Figure  4-13  Description and Icons 

4. In the ‘Current Selection box, pick ‘FAT-32 OS’. In the ‘EDIT DESCRIPTION’ box 
type EyeLink. Under ‘SELECT ICONS’, use the ’+’ and ‘-‘ buttons to change both 
large and small icons to ‘OS’. These steps are illustrated in Figure 4-14. 
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Figure  4-14  Description and Icons Editing 

 

5. Click ‘OK’ to finish. 

6. From the ‘Settings’ window, select ‘Order Add and Remove’ as illustrated in 
Figure 4-15. 

 

Figure  4-15  Order Add and Remove 

7. From the ‘Order Add and Remove’ window, remove all icons except for the 
Windows XP and EyeLink by highlighting each one and clicking the ‘Remove’ 
button as illustrated in Figure 4-16. 
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Figure  4-16  Remove Items 

8. From the ‘Order Add and Remove’ window, highlight the EyeLink OS and click 
the ‘Top’ button to make EyeLink the default partition. 

9. Click ‘OK’ to finish and close the ‘Settings’ window. 

4.1.2.5 Automated boot into EyeLink 1000 Operating System 

1. Start the computer and select the Windows Operating System. 

2. Select the Start Menu and click on System Commander. 

3. Click on Select settings. 
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Figure  4-17  Settings Selection in Windows 

4. Select System Commander General Settings. 

 

Figure  4-18  System Commander General Settings 

5. In ‘Default OS Selection’ select the EyeLink operating system. 
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Figure  4-19  Automatic OS Selection  

6. Click on “Auto-Select after time out”. 

7. Select the time out for 30 seconds and click on the “Next Button”. 

8. Exit System Commander and restart the computer.  

 

4.1.2.6 Install the EyeLink 1000 Operating System and Program Files. 

1. Insert the floppy disk or CD labeled “ROMDOS Boot Disk” that came with the 
EyeLink 1000 system. 

2. Restart the computer. If you are using the boot CD, you may need to press F12 
to change the boot sequence. 

  

IMPORTANT: The following step requires you to determine the correct drive 
letter (c:, d:, etc) for the EyeLink 1000 partition you created above after 
booting with the ROMDOS Boot Disk. Determine this by using the dir 
command (e.g. dir c:) for each drive to find the EyeLink drive label and 
substitute that drive letter (c:, d:, etc) in place of {EYELINK DRIVE}  below. 
It is likely that the drive letter will be either c: or d:   

 

3. At the command prompt 'A:\>’ type the following command: 
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sys {EYELINK DRIVE} [ENTER] 

For example if your EyeLink partition is drive c: you will enter: 

sys c: 

and then press the enter key. 

4. Remove the floppy disk from the floppy drive or the boot CD from the CD Rom. 

5. Reboot the computer and select the EyeLink 1000 partition to boot at the 
System Comander dialog. You should see a c:\> prompt at the command line. If 
you do not, the EyeLink 1000 partition is not bootable and you should repeat 
the steps in this section from the point of booting from the ROMDOS Boot disk. 

6. Reboot your computer and start your original 2000 / XP partition. 

7. Start Windows Explorer. You should see a drive representing the EyeLink 1000 
partition. 

8. Copy the EyeLink 1000 OS files to the EyeLink 1000 drive. Your EyeLink 1000 
system came with a copy of all the files required for the EyeLink 1000 OS 
partition. Please note that each EyeLink 1000 loads a camera-specific .SCD file 
and therefore, you should always use the EyeLink 1000 Installation CD that 
comes with your system. 

i. Insert the “EyeLink 1000 Installation Software” CD into your CD drive 

ii. Open the “Host PC Installation → Host Partition” folder. 

iii. Select the Tools → Folder Options… menu in Windows Explorer. 

iv. Select the View tab. 

v. Select the “Show hidden files and folders” option under Hidden files and 
folders. 

vi. Ensure “Hide extensions for known file types” is not selected. 

vii. Uncheck the “Hide protected Operating system files….” as illustrated in 
Figure 4-20. 
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Figure  4-20 Windows Explorer Tools → Folder Options… 
Dialog. 

 

viii. Press OK. 

ix. Select all files in the “Host Partition” folder of the CD. 

x. Copy these files to the root directory of the EyeLink 1000 drive on your 
computer. 

xi. Select the Tools → Folder Options… menu in Windows Explorer. 

xii. Select the View tab. 

xiii. Deselect the “Show hidden files and folders” option under Hidden files 
and folders. 

xiv. Check the “Hide protected Operating system files….” 

xv. If your host PC uses a USB keyboard please proceed to section 4.1.2.7 
“Create USB Keyboard setup.” 
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xvi. If you have a PS/2 keyboard please restart your computer. You should 
be able to select the EyeLink 1000 drive and boot into the EyeLink 1000 
OS. If this is successful, a command prompt will be displayed. Please 
continue to section 4.1.3 “Testing the Host PC Installation” 

4.1.2.7 Configuring the USB Keyboard 

The PS/2 keyboard is the default driver setup within the EyeLink Host 
directory. If you are using a USB keyboard you shall have to rename the file 
to activate the USB keyboard driver. 

1. Locate the “ELCL.INI” file in the “ELCL\EXE” directory of the host 
partition. Rename it to “ELCL.PS2”.  

2. Rename the “ELCL.USB” file to “ELCL.INI”.  

3. Restart your computer. You should be able to select the EyeLink 1000 
drive and boot into the EyeLink 1000 OS. If this is successful, a 
command prompt will be displayed.  

4.1.3 Testing the Host PC Installation 
The Host PC is now ready to test. Start the EyeLink 1000 Tracker application by 
typing  
 

CD C:\ [Enter] 

T [Enter] 
 

The EyeLink 1000 Host PC application should start and you should see the 
EyeLink 1000 Host application screen illustrated in Figure 4-21. Please make sure 
that you are using version 4.0 or later of the EyeLink 1000 host application; the 
latest host software can be downloaded from SR Research support website 
http://www.sr-support.com. 
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Figure  4-21 EyeLink 1000 Tracker Application in Offline 
Mode at Startup 

IMPORTANT: Each EyeLink 1000 system loads a camera-specific .SCD file. 
If you see the following error when starting up the tracker, please ensure 
that “********.SCD” file is contained in the ELCL\EXE directory. 

ERROR: Camera data file ‘c:/ELCL/EXE/********.SCD’ does not exist 

You can find the camera-specific .SCD file from the EyeLink 1000 software 
CD that comes with your system. If you cannot locate this file, please 
contact SR Research Ltd.  

 

Click on the “Set Options” button to check for the ELCL configuration used (see Figure 
4-22). For the EyeLink 1000 Tower Mount, make sure that the ELCL configuration is 
set to “Tower”. If you are using a Desktop Mount, please make sure that ELCL 
configuration matches the position and angle of the camera used (see section 3.5” 
EyeLink 1000 Desktop Mount Installation”). If you are EyeLink Remote, please select 
“Remote (Level)”. 
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Figure  4-22. Set Options Screen for ELCL Configuration. 

Press [Enter] and you should be taken to the Camera Setup screen where you can see 
the EyeLink 1000 camera image.  

• If you are using an EyeLink 1000 Tower, ask the subject to rest his/her head on 
the chinrest and forehead rest against the forehead rest. You should see part of 
the person’s face, although it may be very blurry. You can focus the camera by 
gently and slowly moving the focus arm that extends out to the right from the 
camera lens.  

• If you are using an EyeLink 1000 Desktop Mount, remove the lens cap from the 
eye camera by pulling it outwards while holding the camera. Loosen both the 
Lock knob and the Friction knob, adjust the tilt of the camera so that the 
intended eye image appear at the proper location of in the global view of the 
camera image. For monocular recording, the tracked eye should appear in the 
center of the camera image (see Figure 4-23). For binocular recording, the tracked 
eye(s) should appear in the center of the respective camera hemifield(s) divided by 
the dotted line. Tighten both knobs once the vertical position of the eye is in the 
intended camera image. The eye camera should be focused by rotating the lens 
holder. 
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A screenshot of the large field of view of the EyeLink 1000 camera (tower Mount) is 
illustrated in Figure 4-23. 

 

 

Figure  4-23  EyeLink 1000 Tracker Application Camera 
Setup screen. 

Please follow Chapter 3 “An EyeLink 1000 Tutorial: Running an Experiment” of the 
EyeLink 1000 for further operation instructions. 

4.2 EyeLink Data Storage 

All EDF files that are created during the recording phase of each experiment will be 
saved to C:\ELCL\DATA. This is the default directory into which EyeLink recording files 
(.EDF) are stored. If the DATA drive cannot be found, all EyeLink data files will be saved 
into the c:\ELCL\EXE directory. It is recommended to periodically boot into 
the Windows 2000/XP operating system to back up your data. Editing the parameters 
in the ‘Data.ini’ file can change the path into which the data is stored.  
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4.3 Display PC 

The Display PC is used to run experiment application software for control of the 
EyeLink 1000 tracker and stimulus presentation through the EyeLink Display 
Software. This API is available on Windows, MacOS and Linux platforms. The Display 
PC installation process is much less complicated than the Host PC installation and 
should not take more than 15 minutes. Installation instructions for the Windows 
platform are detailed below.  

4.4 Windows Installation 

To use Windows as a Display computer with the EyeLink 1000 system, various EyeLink 
software components should be installed on the Windows Display PC. The installation 
process consists of the following basic steps: 

• Install the EyeLink Experiment Programming Kit. 

• Install the supplied IO Port Access Driver. 

• Install the EyeLink Data Viewer and / or Experiment Builder software (if 
purchased). 

• Install the USB Key for EyeLink Data Viewer and / or Experiment Builder 
software (if purchased). 

• Configure the network connection to the EyeLink 1000 Host PC. 

4.4.1 Installing the EyeLink 1000 Experiment Programming Kit 

The Windows toolkit (API and example files) is available on the “EyeLink 1000 
Installation” CD in the “Display PC Installation” directory. To install the toolkit, follow 
these instructions. 

1. Insert CD marked “EyeLink 1000 Installation”. 

2. Open the “Display PC Installation → Windows” folder. 

3. Run the EyeLinkDevKit_*.exe program by double clicking the icon. 

4. Follow the instructions from the InstallShield Wizard to install the display 
software. 

5. Wait for the InstallShield Wizard to finish, and click FINISH to complete 
installation. 
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4.4.2 Installing the IO Port Access Driver 

For proper access to IO ports on the Display PC, an access driver must be installed. The 
EyeLink 1000 Windows API relies on this driver for IO port access so installation is 
mandatory.  

1. To install the driver, click Start → Programs → SR Research → EyeLink → 
Utilities → PORT95NT. 

2. Follow the on screen instructions. 

3. Reboot your computer when prompted. 

4.4.3 Installing the EyeLink Data Viewer and Experiment Builder Software 

The EyeLink Data Viewer and Experiment Builder software are optional Windows 
applications for the EyeLink eye tracker. If you did not purchase these options this 
section may be skipped. If you did not purchase these options and would still like to 
evaluate the software in demo mode you may do so. 

1. Insert CD marked EyeLink 1000 Installation Software. 

2. Open the “Display PC Installation → Windows-> EyeLink Data Viewer” folder. 

3. Run the EyeLinkDV_*.exe program by double clicking the icon. 

4. Follow the instructions from the InstallShield Wizard to install the software. 

5. Wait for the InstallShield Wizard to finish, and click FINISH to complete 
installation. 

6. Open the “Display PC Installation → Windows-> SR Research Experiment 
Builder” folder 

7. Run the SREB_*.exe program by double clicking the icon. 

8. Follow the instructions from the InstallShield Wizard to install the software. 

9. Wait for the InstallShield Wizard to finish, and click FINISH to complete 
installation. 

4.4.4 USB License Key Installation 

If you purchased either the Data Viewer or Experiment Builder software, you will 
have been provided with a USB license key with your order. To install the software 
driver for the USB license key follow these steps: 

1. From the Windows Start menu select “Start->All Programs -> SR Research -> 
Install HASP Driver” 
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2. Follow the instructions from the InstallShield Wizard to install the software. 

3. Wait for the InstallShield Wizard to finish, and click FINISH to complete 
installation. 

4. Insert the USB Key into a free USB port on the Display computer. The USB key 
should start to glow a reddish – purple color, indicating that the key has been 
recognized by the system.  

4.4.5 Setting up EyeLink 1000 Network Connection 

You must have an Ethernet card installed in your Display Computer. Allow Windows to 
install drivers for it (if it is a new card), then follow these instructions to install and 
configure the TCP/IP network protocol. These instructions are based on Windows XP, 
other Windows operating systems may vary slightly. 

1. From the Start menu select the Control Panel. 

2. Click on the Network and Internet Connections icon, and then select the network 
Connections icon. Check the list of installed components to make sure a 
network card is installed. If not, install a driver for the card. 

3. Double click on the network card icon that represents the network card that will 
be connected to the EyeLink 1000 Host PC. 

4. Select the properties button. 

5. Check that “TCP/IP” is displayed in the list of components and that it is 
checked. If not, press the checkmark beside the option.  

6. Select the “TCP/IP” component for the Ethernet card connected to the eye 
tracker PC, then click on the “Properties” button.  

7. Select the “Use the following IP address” radio button. Enter the IP address of 
“100.1.1.2”. The last digit of the IP address can increase for other computers 
on the EyeLink network. Enter the subnet mask of “255.255.255.0”. Leave the 
default gateway and other setting blank.  

8. Click on “OK” to return to the Properties dialog. Click “OK” again to save your 
changes. Click “Close” to exit from the network card dialog. 

You should now restart Windows. If error messages appear at startup, you may need to 
reinstall the network card drivers. To be safe, open the Network dialog and remove all 
components, restart Windows, then install the network card driver and the TCP/IP 
protocol again.  
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To test the network, start the EyeLink 1000 tracker and start the track application from 
“Start -> Programs -> SR Research -> EyeLink -> Track”. The link should connect, and 
the screen will display instructions. This application allows you to practice participant 
setup and test the system, as described in the EyeLink 1000 installation guide. If the 
message “Cannot initialize link” appears, the TCP/IP protocol is not properly 
configured. If the connection times out, it is probably due to the network card being 
improperly configured or because the network cable is not connected to both PCs. 

4.4.6 System and Programming Tools Required 

The experiment templates in this package were developed using Microsoft Visual C 6.0. 
Other 32-bit C and C++ compilers may be used, but you will have to translate the 
included make files to rebuild the experiments. This release of the Windows Display 
Software does not supply examples for C++ programming. 
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5. Final Installation Steps 

This section lists the final installation steps to fine tune your EyeLink 1000 installation. 

5.1 Customizing Your PHYSICICAL.INI Settings  

The EyeLink 1000 PHYSICAL.INI file at C:\ELCL\EXE directory contains settings that 
tell the system about physical characteristics of your setup that are important for 
proper visual angle and eye velocity calculations. Any time you change your physical 
configuration you should verify that the PHYSICAL.INI still accurately reflects your 
setup.  

The parameters in the PHYSICAL.INI file that change depending the physical setup of 
your system are: 

screen_phys_coord – specifies the physical distance of the four edges of the 
presentation surface, to the center of the screen. The order of these measurements is 
left, top, right, bottom and are specified in millimeters. For the default case of a 19” 
monitor this parameter will read. 

screen_phys_coords = -178.0, 135.0, 178.0, -135.0 

screen_pixel_coord – specifies the resolution of the display surface. Normally the 
EyeLink 1000 API at the start of an experiment programmatically adjusts this so you do 
not need to manually change this setting. If the EyeLink 1000 programming API or 
Experiment Builder is not being used, then the default value for this parameter will 
apply. The default value reads.  

screen_pixel_coords = 0.0, 0.0, 1024.0, 768.0 

screen_distance – specifies the distance to the top and bottom of the display surface 
from the participant’s eye. This setting is not applicable to EyeLink remote tracker. The 
default values read as following:  

screen_distance = 600 660 
 

5.1.1 Measuring screen_phys_coords 
 

All screen physical coordinate measurements are in millimeters. It is recommended that 
a straight ruler be used. Turn on both the EyeLink 1000 Host and Display PC and run 
track.exe on the Display PC. Type in “TEST” for the saved EDF file name and click the 
OK box. Press “Enter” on either keyboard twice.  
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On the Host PC go to “Set Options” on the screen and select “mouse simulation” mode. 
This will now let you use the Host PC mouse to simulate eye movements. Check that 
the Calibration Type is set to a nine-point pattern. Press “Previous Screen” button to 
return to the Camera Setup screen. 

Now press “C” or the calibration button. A calibration dot should appear on the middle 
of the display monitor. Use this dot as the central reference point for all horizontal and 
vertical PHYSICAL.INI measurements. 

In the screen_phys_coors, measure the distance from the center of the dot to the end of 
the active part of the monitor screen. Start on the left side (S1) and follow round to the 
top (S2), right (S3) and bottom (S4). This is illustrated in Figure 5-1. 

 

 

Figure  5-1 Measuring screen_phys_cords 

The new settings for the screen_phys_coords in the PHYSICAL.INI file are determined by 

screen_phys_coords = -1, 2, 3, -4  
 

5.1.2 Measuring screen_distance 

Please follow the steps below to measure the “screen_distance” values. For EyeLink 
Remote eye tracker, keep the default “screen_distance” value. 

1. Set up the monitor and chinrest so that the chinrest is centered on the monitor and 
the monitor is horizontally aligned with the chinrest (HINT: measure from the left 
and right knobs on the chinrest to the left and right sides of the top of the display 
area of the monitor, these should be equal).  
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2. Adjust the height and tilt of the monitor. Ideally this should have the top of the 
display at about the same height as the forehead rest, and the display tilted up 
slightly. The tilt can be changed if there are any reflection issues. Small amounts of 
horizontal misalignment (turning of the monitor) may be tolerated if required to 
reduce screen reflections, but this will reduce the accuracy of angular measures. 

3. Now measure from the front of the forehead rest/tower height adjustment knob (or 
the subject’s eye position if using your own chin rest) to the point on the monitor 
directly in front of the knob (lay the measuring tape across the top of the shaft of 
the knob, and read distance from the front of the column). Measure from the knob 
to the top of the visible part of the display area, then from the knob to the bottom of 
the display area. These two values (in millimeters) should be your new 
“screen_distance” command values.  

5.1.3 Entering Values into PHYSICAL.INI 
 

The newly acquired values for “screen_phys_coords” and “screen_distance” must now 
be entered into the PHYSICAL.INI located on the Host PC. This can be done either from 
the Windows partition or from the EyeLink partition. 

5.1.3.1 Windows Partition 

Boot into the Windows partition, find the EyeLink drive. Go to the “ELCL\EXE” 
directory and select the PHYSICAL.INI file. Uncheck the "read-only" property of the file. 
Modify the file and save the change. 

5.1.3.2 EyeLink Partition 

Reboot the Host PC into the EyeLink partition. Do not press “T” when in the DOS 
prompt before running the EyeLink 1000 GUI.  

 
From the command prompt type the following 
 
 CD C:\ELCL\EXE 

 ATTRIB –R PHYSICAL.INI 

 EDIT PHYSICAL.INI 

 

To enter the new values, follow these steps 
 

1. Go to the screen_distance parameter 

2. Remove the default values for this command. 

3. Enter new values 
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4. Repeat steps 1-3 for screen_phys_coords 

5. Save changes and exit the file 

 
Finish by typing the following at the command type 
 ATTRIB +R PHYSICAL.INI 
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